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Safety in the first year laboratory (CG 021)
The Health and Safety at Work Act was introduced in 1974. Since then many regulations have been
made under the act, for example, The Control of Substances Hazardous to Health (COSHH). The
University has a statutory obligation to comply with these requirements and you, as a student, have
a duty to abide by the regulations. The following notes are to guide you in good laboratory practice
and to familiarise yourself with the safety aspects of your laboratory work.
Emergency Telephone Numbers
Internal telephones: FIRE, POLICE, AMBULANCE
9999
UNIVERSITY EMERGENCY NUMBER 43333
1.

Staff with special responsibilities for safety:
Chairman of the Board of Studies:
Professor J S O Evans
Chemistry Safety Officer:
Dr J A G Williams
Undergraduate teaching laboratories:
Dr E Wrede (Physical Chemistry)
Dr J A G Williams (Inorganic Chemistry)
Dr E Khosravi (Organic Chemistry)

2.

No work is to be carried out unless a member of staff is present.

3.

All persons in laboratories (whether or not they are actually doing practical work) must wear
safety spectacles and laboratory coats. Academic staff supervising undergraduates enforce
this rule. In all laboratories, hair should be secured so that it does not hang below the neck.
It is important to wear suitable clothing, and your footwear must incorporate flat heels, slipresistant soles and uppers fully enclosing the foot.

4.

Foods, drinks, cosmetics and cigarettes must not be taken into or used in areas where
chemical substances are used or kept.

5.

Bags and coats should be placed in the lockers provided outside the laboratory and not left
in corridors or on benches.

6.

All accidents and dangerous occurrences must be reported immediately to a member of
staff or a demonstrator. The first aid box is located in the foyer area and a list of qualified
first aiders is on the front. The accident book is kept in room CG 058 and the member of
staff in charge of the laboratory must fill out a report for all incidents. An emergency shower
is located in the foyer area and there are four eyewash stations beside the sinks. There is a
chemical spillage treatment kit in CG195.
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7.

The fire action signs in the laboratory indicate the nearest fire alarm and the emergency
exit. There are two carbon dioxide fire extinguishers on either side of the central pedestal
and another in the instrument room. There is also a foam spray fire extinguisher on either
side of the central pedestal and one at each fire exit. A general fire practice is held twice
yearly to check the smooth operation of the procedure so you should ensure that you know
where to go in an emergency.

8.

Pipetting by mouth is not allowed. Use a bulb or automatic pipette.

9.

Do not inhale vapours or make skin contact with any substances. Use gloves where
necessary always remembering that they are semi-permeable.

10.

Experiments must be conducted on clean working surfaces; any spillage should be cleaned
immediately. A high standard of tidiness should be maintained at all times. Contaminated
surfaces and equipment must be cleaned as soon as it is practicable after use. The
equipment should then be put away. Do not clutter bench-space with unused equipment
and bottles of chemicals.

11.

Waste should be disposed of in the appropriate containers: solvents should be placed in
either C, H, N, O-containing waste solvent bottles (Category C Waste), or halogen, sulphurcontaining waste solvent bottles (Category D Waste). Heavy metal waste should be placed in
the appropriate bottle. Broken glassware should be washed and placed in the designated
glass bin. Solid waste should be dried, placed in a polythene bag and placed in a solid waste
bin. A sharps bin is located in CG195. Consult a demonstrator if you are unsure about the
correct disposal procedure.

12.

The COSHH assessment of any chemical you use or make will be given in the laboratory
script. There are further safety warnings at the appropriate parts of the text. Staff and
student demonstrators reinforce these. If you are in any doubt, consult a demonstrator.

13.

No unauthorised experiments are to be carried out.

14.

It is important to ensure that hands are washed and all protective clothing removed before
leaving the laboratory.
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Introduction
Chemistry is an experimental science and, as well as attending lectures, both the University and the
Royal Society of Chemistry, who accredit your degree, require you to complete a designated
number of hours of laboratory work. During the first year, 18 weeks of practical work must be
completed. The first year practical course is split into four sections:
1. Induction (Week 1)
2. Skills (Weeks 2-7)
3. Discovery (Weeks 8-16)
4. Projects (Weeks 18-19).
During the next three weeks, you will complete Block 2 of the Skills section. This contains activities
designed to ensure that you are familiar with, and have practised, some of the key skills required in
the chemistry laboratory. Some of these will be familiar to you from your pre-University studies,
but this will vary from person to person. This section will also introduce the various resources you
can use in your own time, away from the laboratory, to ensure you are confident in your work and
make the most of your time in the laboratory.
1.1 The pre-lab exercises
Before every laboratory session, one or more pre-lab exercises must be completed. These may
involve reading, watching video clips, answering questions or using interactive software to rehearse
techniques. The instructions for these exercises will be accessed via DUO, the university Virtual
Learning Environment. Becoming familiar and comfortable with the use of DUO is one of the aims
of this section.
Pre-lab exercises will often contain summative aspects (i.e. the marks will count towards the overall
marks for the Laboratory Course), and they must be completed in the week before you attempt the
laboratory activity. All pre-lab work must be finished an hour before the relevant laboratory session
so that completion can be checked. For example, a student attending the Thursday laboratory
session, which begins at 2.00pm, must have completed the pre-lab exercises by 1.00pm that same
day. Anyone arriving at a laboratory session without having completed the pre-lab exercises will be
sent away to complete them before being allowed to begin work in the laboratory. Failure to
complete the pre-lab exercises on time will incur a marks penalty. Your time in the laboratory will
become very pressured if you are sent away to complete the pre-lab exercises. Good time
management is the key to success in most areas of university life, but particularly in your laboratory
work!
If there are any problems with access to DUO or LabSkills using personal computers, there are
open-access machines available for use in the library and at other points around the science site.
There may also be provision in college. Ask for help if problems arise when accessing the pre-lab
exercises. Failure to access the exercises will not be accepted as a reason for incomplete pre-lab
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work unless the laboratory course leader (Dr J. M. Robson) is informed in advance of the deadline
so alternative arrangements can be made.
1.2 LabSkills
Many pre-lab exercises will involve you using LabSkills. This is an electronic laboratory textbook for
you to use to gain confidence in assembling and using apparatus before you begin work in the
laboratory. Interactive exercises are designed to allow you to practice key techniques and learn
more about apparatus and safety as you progress through the course. During the Skills section of
your laboratory course, the pre-lab exercises will be very prescriptive in their use of LabSkills. You
can, however, access it at any time during your undergraduate career at Durham to refresh your
memory of any basic techniques and skills before any practical class. LabSkills also contains useful
glossaries and worked examples of calculations that you will find useful. It will be accessible in the
laboratory for additional assistance if you need it.
1.3 The laboratory sessions
One laboratory session per week will be assigned to Core Chemistry 1A, and a second session per
week for Core Chemistry 1B. Experiments that will count towards Core Chemistry 1A will contain a
suffix of ‘A’ in the title (e.g. Experiment 7A) and will be carried out by everybody. Experiment titles
containing a suffix of ‘B’ (e.g. Experiment 7B) will count towards Core Chemistry 1B and will be
carried out only by those studying Core Chemistry 1B.
In this term (Michaelmas), University weeks begin on a Thursday and end on a Wednesday. Those
students only studying Core Chemistry 1A will be assigned one laboratory session per week and will
carry out all of the ‘A’ experiments. Those students also studying Core Chemistry 1B will be
assigned two sessions per week. The first session of the week is assigned to be the Core Chemistry
1A session, and the second session of the week is the Core Chemistry 1B session. For example, if
the two allocated laboratory sessions are on Thursday morning and Monday afternoon, the Core
Chemistry 1A session will be Thursday morning, when an experiment with the suffix ‘A’ will be
performed, and the Core Chemistry 1B session will be Monday afternoon, when the ‘B experiment
for that week will be completed.
Laboratory sessions will be allocated during one or two of the following times:
Thursday
9.00am - 12.00pm
Friday
9.00am - 12.00pm
Friday
2.00pm - 5.00pm
Monday
9.00am - 12.00pm
Monday
2.00pm - 5.00pm
Tuesday
2.00pm - 5.00pm
Wednesday 10.00am - 1.00pm
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You may only attend the laboratory at your allocated time. A risk assessment is provided in this
manual for the chemicals used in each experiment. This must be read carefully before attending the
laboratory, and the advice followed throughout each laboratory session. All experimental work
must be completed in that laboratory session and your lab notebook and work space signed off
before you leave.
1.4 Set Allocation
Students in each laboratory session are allocated to one of three named sets of no more than 20
students. Sets are named after chemical elements and students are assigned to sets in no particular
order. Lists showing members of each set are available on DUO and details should be written onto
the front of the laboratory manual. Each set will tackle a different activity each week, in a three
week cycle, until everyone has completed each activity. The three experiments in the laboratory
will then change and each set will again work through each experiment according to the rota.
Set names are as follows:
Thurs am
Friday am
Friday pm
Monday am
Monday pm
Tuesday am
Wednesday am

Set 1
actinium
dysprosium
gadolinium
potassium
niobium
rhodium
uranium

Set 2
Set 3
bismuth
cobalt
erbium
fluorine
hafnium
yttrium
lithium
molybdenum
phosphorus
osmium
strontium
tantalum
vanadium
tungsten

You will already have been allocated one set for the Core Chemistry 1A session and a second set for
the Core Chemistry 1B session. Set lists are available on DUO. Sets will perform experiments
according to the following rota:
Week
5
6
7

Set 1
Experiment 5
Experiment 6
Experiment 7

Set 2
Experiment 6
Experiment 7
Experiment 5

Set 3
Experiment 7
Experiment 5
Experiment 6

For example, in week 6, everyone in Set 2 will carry out Experiment 7. Those studying only Core
Chemistry 1A will only complete Experiment 7A. Those students also studying Core Chemistry 1B
will complete Experiment 7B during their second session of the week. You will find your allocated
sets on DUO and you should write the details onto the front of this laboratory manual. Contact Dr J.
M. Robson (j.m.robson@durham.ac.uk) with any queries relating to sets or the experiment rota.
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1.5 Assessment
Pre-lab exercises will contain assessed components. These exercises will differ between
experiments, but assessed aspects will be highlighted. Completion of these exercises is compulsory
and there will be a marks penalty for non-completion. The pre-laboratory exercise marks will make
up 10% of the total marks for the practical course.
During each laboratory session, work and progress will be assessed. Completion of the lab
notebook and performance in the practical tasks will be given marks. Occasionally there will be a
small amount of post-laboratory work that will need to be completed to finish each experiment.
Marks will be awarded during laboratory sessions throughout the year and will make up 10% of the
total marks for the practical course.
In the Skills section, the focus is on the development of a good general technical skill base to be
used throughout your practical work at University. There will be one small additional assessed
written exercise for those students studying Core Chemistry 1B. From Week 8 onwards, in the
Discovery and Projects sections, there will be additional assessed exercises for all students that will
count towards your total marks for the practical course.
1.6 Assessment summary (bold indicates activities to be completed during Skills)

Pre-lab exercises (whole year)
Laboratory session marks (whole year)
SKILLS Experiment 5B:
Determination of the enthalpy of vaporisation of ethanol
DISCOVERY Experiment 10A
DISCOVERY Experiment 10B
DISCOVERY Experiment 11B
DISCOVERY Experiment 12A
DISCOVERY Experiment 15A
DISCOVERY Experiment 15B
PROJECT

Core Chemistry
1A
10 %
10 %
-

Core Chemistry
1B
10 %
10 %
5%

20 %
20 %
20 %
20 %
100 %

15 %
20 %
20 %
20 % *
100 %

*50 % of the project mark for students completing both Core Chemistry 1A and Core Chemistry 1B
will be allocated towards the Core Chemistry 1A total marks, and 50 % will be allocated towards the
Core Chemistry 1B total marks.
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1.7 Supervising staff and postgraduate demonstrators
SKILLS Block 2 – week 5 to week 7 (Thursday 3rd November to Wednesday 23rd November 2011)
Senior Demonstrators (staff)
Dr Jacquie Robson*
Prof Mark Wilson
Dr Lars Palsson
Dr Andy Beeby
Dr David Carty
Dr Pippa Coffer

Junior Demonstrators (postgraduate students)
Philip Brown
Rachel Carr
Alex Dudgeon
Becky Edwards
Ricardo Girling
Santi Marques Gonzales
Peter Harvey

* Laboratory course leader - email: j.m.robson@durham.ac.uk
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SKILLS
BLOCK 2
EXPERIMENT 5A
PREPARATION OF AN ANIONIC
AND A CATIONIC COMPLEX OF
NICKEL
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SKILLS

EXPERIMENT 5A

5A. Preparation of an anionic and a cationic complex of nickel
An introduction to the study of coordination chemistry is provided in the pre-lab exercise. In this
experiment, two different 1st row transition metal complexes (coordination complexes) of nickel
will be prepared.
5A.1 Aims
 To develop knowledge of fundamental aspects of coordination chemistry and ligands
 To prepare K4[Ni(NCS)6].4H2O, an anionic nickel complex with thiocyanate ligands and a
positive counterion
 To prepare [Ni(NH3)6][BF4]2, a contrasting cationic nickel complex with ammonia ligands and
negative counterion
 To gain more practice in synthetic chemistry and in working efficiently
 To increase familiarity with purification techniques such as recrystallisation
 To practice equation writing/balancing for systems containing transition metal complexes
 To develop spelling, punctuation and grammar abilities in the context of scientific writing
5A.2 Pre-lab exercises
These exercises must be completed at least one hour before the timetabled start time of the
laboratory session. Students not completing the pre-laboratory task will be turned away from the
laboratory until the exercises are completed.
1. Read your laboratory instructions through carefully and highlight unfamiliar words or
apparatus.
2. In DUO, in the Core Chemistry 1A Laboratory Course section, open Foundation Chemistry
LabSkills and click to begin. Click on the ‘Equipment Glossary’ or the ‘Reagent Glossary’ at
the top of the screen to identify any unfamiliar words contained in your laboratory manual
script. Look again over any techniques to be used in the experiment (e.g. Buchner filtration).
3. Using DUO, find and open the document entitled ‘Experiment 5A: Introduction to
Coordination Chemistry pre-laboratory exercise’. This Word document provides background
information about coordination chemistry and should be read carefully. Note that the
document contains numerous spelling, punctuation and grammar errors (but the chemistry
is sound!). Save a copy of the document with an appropriate filename containing first your
surname, then your first name, then the experiment number. For example, if you are called
Joe Bloggs, a suitable filename would be BloggsJoe5A.doc. After reading the text thoroughly,
ensure that the ‘Track Changes’ option in Word (which can be located in the Review tab in
Word 2010) is turned on and begin to make corrections to the document. ‘Track Changes’
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means that all the editing can be seen clearly. To assist with this exercise and to give hints as
to what to look for, read the document entitled ‘Experiment 5A: Top 10 English Writing
Issues’ (available in DUO). There are approximately twenty errors contained within the
document. Once all the appropriate changes and corrections have been made (which should
all be highlighted via the ‘Track Changes’ tool), submit the document via DUO, making sure
that the number of errors found and changes made are stated in the Comments section at
the point of submission.
4. Prepare the lab notebook. Be sure that the methods for both experiments have been read in
detail. Good time management and efficient working in the laboratory are essential if both
syntheses are to be completed in one laboratory session. Ensure that the risk assessment
has been read and notes made in the lab notebook about specific hazards. In this
experiment, thiocyanate ligands will be used. Look up and record the difference between
‘cyanide’ and ‘cyanate’, and note the meaning of ‘thio’ in a chemical name.
5A.3 Risk Assessment
CHEMICAL

RISKS

SAFETY

Nickel(II) nitrate
hexahydrate,
Ni(NO3)2.6H2O

Harmful. May cause cancer. Avoid
contact with skin. Contact with
combustible material may cause fire

Wear suitable protective clothing
and gloves.

Ethanol, CH3CH2OH

Flammable.

Potassium
thiocyanate, KSCN

Keep away from sources of
ignition.
Harmful by inhalation, in contact with Wear gloves. Avoid release to
skin and if swallowed. Irritant. Contact the environment.
with acids liberates very toxic gas.
Harmful to aquatic organisms, may
cause long-term adverse effects in the
aquatic environment

K4[Ni(NCS)6].4H2O

Harmful. May cause cancer. Avoid
contact with skin.

Wear gloves.

Nickel chloride
hexahydrate,
NiCl2.6H2O

Toxic if swallowed. Carcinogenic.
Irritating to eyes and skin. Avoid
contact with skin. Toxic in the
environment – may cause long term
damage.

Avoid exposure. Wear suitable
protective clothing and gloves.
This material and/or its container
must be disposed of as hazardous
waste. Avoid release to the
environment.
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Sodium
tetrafluoroborate,
NaBF4

Harmful. Causes burns. Avoid contact
with skin.

Wear gloves.

Concentrated
ammonia

Flammable. Toxic by inhalation.
Causes burns. Very toxic to aquatic
organisms. Can cause irreparable
damage, particularly to eyes.

Dilute ammonia

Irritant. Can cause burns.

Hexaamminenickel
chloride,
Ni(NH3)6Cl2

May cause cancer. Harmful. May
cause sensitisation – avoid contact
with skin.

Use only in fume cupboard. Wear
suitable protective clothing,
gloves and eye/face protection.
Keep away from sources of
ignition.
Wear gloves. Do not breathe
vapour. Use in fume cupboard.
Wear gloves.

[Ni(NH3)6][BF4]2

Harmful. May cause cancer. Avoid
contact with skin.

Wear gloves.
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5A.4 Laboratory Activity
Work in pairs for these two experiments, and work in a fume cupboard throughout. Work
efficiently but work together so that observations can be recorded by both members of the team.
Good team work and time management is essential to get these experiments completed in the time
available. Choose a work area with a free locker and select a fume cupboard. Write the number of
these at the top of the lab notebook page for this experiment. Show a demonstrator the lab
notebook for marking and inform the demonstrator of the locker and fume cupboard number. It
is essential that you work well as a team and that all work is carried out quickly and efficiently to
ensure that both syntheses are completed within the laboratory session. There are breaks in each
method where time is needed to wait for recrystallization or for products to suck dry. Use this time
to continue with the other synthesis. It will be difficult to prepare both products in one session if
they are performed one after the other, so plan your work carefully and use all available time. Good
team work is the key, and your ability to work well as a team will be assessed.

Preparation of a Thiocyanato-Nickel Complex K4[Ni(NCS)6].4H2O
1. Wear gloves throughout the experiment, and work in a fume cupboard throughout. Using
an appropriate balance for synthetic work, weigh out 3.0 g of nickel(II) nitrate hexahydrate,
Ni(NO3)2.6H2O, and record the mass used. Dissolve in the minimum volume of hot ethanol
(less than 5 cm3) in a small conical flask on a stirrer hotplate.
2. Weigh out 2.0 g of potassium thiocyanate, KSCN, and record the mass used. In a second
small conical flask, dissolve it in the minimum volume (approximately 5 cm 3) of hot water
and then add approximately 10 cm3 of ethanol. Think carefully about the apparatus used to
measure out these approximate volumes and use no more precision than is necessary.
3. Mix these two solutions together, with stirring and allow to cool slightly. A precipitate
should form. Note all observations in the lab notebook and deduce the identity of this
precipitate.
4. Remove the precipitate by vacuum filtration. Wash the precipitate twice with small amounts
of alcohol, ensuring all washings are combined with the filtrate (the mother liquor). Keep
the filtrate.
5. Prepare a 1:1 mixture of ethanol and water and heat it. Weigh out 3.8 g of potassium
thiocyanate and record the mass used. Dissolve the solid in the minimum volume of the hot
ethanol/water mixture in a conical flask.
6. Add the filtrate to the potassium thiocyanate solution. Transfer the mixture to a flat
bottomed evaporating basin. Stir well and heat on a stirrer hotplate until the solvent volume
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has reduced to approximately 5 cm3. Supervise this stage carefully to avoid the solution
boiling dry. Do not let the volume decrease too much or it will set solid in the next stage.
7. Remove the solution from the heat and cool it in a cold water bath. Crystals should begin to
form. If crystallisation does not begin after a few minutes, carefully re-heat the solution with
stirring until the volume has reduced further, and then cool again. Repeat this process until
crystals begin to form within a few minutes of cooling. Once crystals begin to form, use an
ice bath to cool further.
8. Collect the product by vacuum filtration, wash quickly with two small portions
(approximately 5 cm3) of cold ethanol. Suck dry. Record the mass of the product. Calculate
the percentage yield (based on the mass of the nickel(II) nitrate hexahydrate used) and
record it, with working, in the lab notebook. Place the sample in a clean, labelled sample
bag (not a weigh bottle!). Wash up all apparatus, thinking carefully about the disposal of any
waste. Nickel salts are toxic and carcinogenic and must not be disposed of down the sink –
use the metal waste disposal receptacle. Return all equipment to the lab lockers. Hand the
sample to the demonstrator for marking.
9. Write balanced equations for the formation of K4[Ni(NCS)6].4H2O. Draw the structure of the
product, thinking carefully about what is acting as a ligand and what is acting as a counter
ion. Show the charge on the transition metal complex and its shape, and the shape and
charge of any counter ions. Show the demonstrator the lab notebook for marking.
Preparation of an Ammine-Nickel Complex [Ni(NH3)6][BF4]2
1. Wear gloves throughout the experiment, and work in a fume cupboard throughout. Using
an appropriate balance for synthetic work, weigh out 1.5 g of nickel(II) chloride hexahydrate
and record the mass used. Dissolve in the minimum volume of water (approximately 2.5
cm3) in a small beaker or conical flask and slowly add concentrated (0.88 density) ammonia
solution (3 cm3). A large amount of violet hexaamminenickel chloride, [Ni(NH3)6]Cl2, should
form. The solution can be cooled to assist the precipitation. Record observations in the lab
notebook and deduce and draw the structure of the hexaamminenickel chloride salt. Show
the crystals and the lab notebook to a demonstrator.
2. Re-dissolve the crystals by adding cold water (4 cm3) and stir well.
3. Remove any undissolved material by vacuum filtration. Keep the filtrate – this is the nickel
solution required in step 5.
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4. Dissolve sodium tetrafluoroborate, NaBF4, (1.3 g) in the minimum volume of dilute ammonia
(boil the solution gently for a few minutes and if any silicate impurity precipitates, filter the
solution to remove it).
5. Add this NaBF4 solution slowly, with stirring, to the nickel solution from step 3, whereupon
the product should precipitate. Record observations in the lab notebook.
6. Isolate the product by vacuum filtration; wash it with dilute ammonia solution until the
washings are colourless, then wash with acetone and suck dry. Transfer to a pre-weighed
watch glass and record the mass of the product. Write a balanced equation for the synthesis
and hence calculate the percentage yield (based on the mass of the nickel(II) chloride
hexahydrate used) and record it, with working, in the lab notebook. Place the sample in a
clean, labelled sample bag (not a weigh bottle!). Hand the sample to the demonstrator for
marking.
7. Wash up all apparatus, thinking carefully about the disposal of any waste. Nickel salts are
toxic and carcinogenic and must not be disposed of down the sink – use the metal waste
disposal receptacle. Return all equipment to the lab lockers.
8. Draw the structure of the [Ni(NH3)6][BF4]2 product, thinking carefully about what is acting as
a ligand and what is acting as a counter ion. Show the charge on the transition metal
complex and its shape, and the shape and charge of any counter ions. Write down how this
nickel complex compares and contrasts to K4[Ni(NCS)6].4H2O. Note down why the product
isolated from aqueous solution was washed with acetone. Show your answers to the
demonstrator. Have the tidy work space, fume cupboard and laboratory locker signed off
by the demonstrator.
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SKILLS
BLOCK 2
EXPERIMENT 5B
DETERMINATION OF THE
ENTHALPY OF VAPORISATION
OF ETHANOL
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SKILLS

EXPERIMENT 5B

5B. Determination of the enthalpy of vaporisation of ethanol
The vapour pressure (p) of a liquid whose vapour is ideal varies with temperature according to the
following equation (the Clausius-Clapeyron equation):

ln p 

  vap H
RT

 constant

where vapH is the enthalpy of evaporation, and T the temperature in K. Therefore a plot of ln p
against T ‒1 should be linear with a negative gradient. From the gradient, vapH may be calculated
using the correct value for the gas constant.
5B.1 Aims
 To determine the enthalpy of vaporisation of ethanol and its standard error using the
variation of its boiling point with pressure.
 To use a trolley pump and vacuum distillation apparatus to collect a data set to allow
determination of the enthalpy of vaporisation of ethanol.
 To become familiar with the use of liquid nitrogen as a cold trap.
 To use Excel to produce a graph and to perform linear regression on the data.
 To produce a brief written report, using Excel and Word, to summarise the analysis and
findings of the experiment.
5B.2 Pre-lab exercises
These exercises must be completed at least one hour before the timetabled start time of the
laboratory session. Students not completing the pre-laboratory task will be turned away from the
laboratory until the exercises are completed.
1. Read the instructions in the laboratory manual through carefully and highlight unfamiliar
words or apparatus.
2. In DUO, in the Core Chemistry 1A Labs section, open Foundation Chemistry LabSkills and
click to begin. Click on the ‘Equipment Glossary’ or the ‘Reagent Glossary’ at the top of the
screen to identify any unfamiliar words contained in the laboratory manual.
3. In LabSkills, select the Distillation option from the menu and work through the content,
including the Technique, the Video and the Safety sections. If this will be the first time a
distillation has been performed, ensure this preparation is carried out thoroughly.
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4. Using the Chemistry Interactive Lab Primer (http://chem-ilp.net), click on the Lab
Techniques tab and select Distillation from the menu. Look through the advice given for
Simple Distillation, then pay extra attention to the Vacuum Distillation section.
5. Ensure that that access is available to a version of Excel to enable the completion of the
written report. Install the Data Analysis Toolkit (following the instructions given in Appendix
1) if it is not available. Excel is now able to perform linear regression on the data set
produced in this experiment. Linear regression is a mathematical approach to determining
the best fit line for a data set. Practice performing linear regression on the example data set
provided on page 22.
6. This experiment will use liquid nitrogen as a cold trap. Research the properties of liquid
nitrogen, find out how it is produced industrially, the boiling point and details of at least two
industrial uses of it. Find out how and why liquid oxygen can form when using liquid
nitrogen in the laboratory, and why it is hazardous. Make a note of your findings in an
appropriate place in your lab notebook.
7. Prepare the lab notebook for the experiment, including a brief summary of the findings
about liquid nitrogen, a link to the method to be used (or an expanded method, if preferred)
and construction of the results table. [Hint: The equipment will be adjusted to give at least
12 different pressures, and the temperature at which the liquid boils will be recorded at
each of these different pressures.] Look up and make a note of the normal boiling point of
ethanol.
5B.3 Risk assessment
CHEMICAL

RISKS

Liquid nitrogen

Causes severe burns. Risk of Avoid contact with skin and eyes. Wear
asphyxiation in confined areas.
suitable protective clothing and gloves.
Use in a well-ventilated area.
Flammable.
Keep away from sources of ignition.

Ethanol, CH3CH2OH

SAFETY

This experiment has more than the usual potential hazards. Please follow the instructions
carefully and wear your safety glasses at all times. IF IN DOUBT, ASK!
Liquid nitrogen is used to trap any ethanol before it gets into the vacuum pump. Handle liquid
nitrogen carefully, avoid splashing it on to yourself or others - it can cause burns. Do not seal any
vessel containing liquid nitrogen, it is boiling continuously and a catastrophic pressure build can
ensue. Liquid nitrogen is not dangerous if allowed to evaporate, but can be absorbed into material,
and when in contact with skin can cause burns.
Remove all jewellery from hands and wrists (including watches) for the duration of the
experiment.
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5B.4 Laboratory activity
Work in pairs. Make sure that the distillation apparatus is clean and then wash it out with ethanol.
Put about 70-80 cm3 ethanol in the distillation flask and place the apparatus in the isomantle
clamping the apparatus at the condenser. Fit the thermometer and connect the lead from the
vacuum system. Fill (about three-quarters full) the Dewar vessel with liquid nitrogen. With the
safety tap open, turn pump on, close the safety tap (i.e. close the air intake) and place the Dewar
around the trap near the vacuum pump. Introduce the Dewar to the trap slowly to minimise
thermal stress. Make sure that the system is evacuated and sealed before the liquid nitrogen is
placed around the trap. Adjust the inflow of air into the system using the screw clips and the fine
needle valve until the pressure is about 950 mbar. Switch on the isomantle and record the steady
temperature and pressure once the ethanol has been boiling for a few minutes. Then reduce the
pressure slowly (by reducing the air inflow) to about 850 mbar and re-determine the steady boiling
point. Repeat until you have at least 12 readings approximately in the range 950 to 300 mbar. Each
member of the pair should produce a graph of the results, by first calculating and then plotting ln(p)
against T ‒1, on graph paper and this should be stuck into the lab notebook. Show a demonstrator
the results.
At the end of the experiment, switch off the heater. Remove the Dewar flask carefully, and slowly
discard the liquid nitrogen by pouring on to the floor. Allow at least 10 seconds for the trap to
warm, let air into the system until it is all at atmospheric pressure and then switch off the pump.
Disconnect the apparatus, discard the ethanol into the solvent C waste Winchester in the fume
cupboard and put all glassware away. Have demonstrator sign off the tidy workspace. Before
leaving the laboratory, ensure that all queries about the production of the laboratory report and
the analysis have been answered. It is expected that most students will complete the practical work
well within the three hours allocated for the experiment and that the post-laboratory exercise can
be carried out immediately afterwards.
5B.5 Post-lab exercise - production of a brief laboratory report
Once the practical work is completed, the results should be analysed and a brief report produced.
Guidelines for the production of the report are given below. It is expected that the report will be
written immediately after the laboratory work is completed, within the time of the usual laboratory
session. The report must be completed and submitted via DUO within 24 hours of the end of the
laboratory session. Reports should be produced independently. A copy of the report should be
printed and stuck into the lab notebook. The analysis for this experiment should be completed
using Excel on a computer.
Plot lnp against T ‒1 in Excel. Make sure that only your raw data is input into Excel and use the
spreadsheet to perform the calculation of lnp and T ‒1. Note that the temperature must be an
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absolute temperature (i.e. in Kelvin). Be sure to use Excel carefully to produce a clear, labelled
graph and use linear regression (explained below) to produce a best fit line and determine the
associated errors. Calculate vapH from the gradient of the line and also determine the normal
boiling point of ethanol.
Notes on use of Excel are available in Appendix 1 on page 22. Use Excel to calculate the standard
errors on your gradient and intercept. Compare your value of the enthalpy of vaporisation of
ethanol with the value from the literature looked up as part of the pre-lab exercises. Be sure to
reference the origin of this literature value.
5B.6 Report guidance
Reports should be prepared using Microsoft Word and Excel, should be brief (no more than 2 A4
side including graphs and tables) and should be submitted electronically via DUO within 24 hours of
the end of the laboratory session. A paper copy of your submission should be stuck into the lab
notebook to follow the notes from the experiment.
Be sure to include:
1. Experiment title and reference, your name, laboratory partners’ names, experiment date.
2. Titled and fully labelled Excel-produced graphs. Note that tabulated data should be included
in an appropriate format, as recorded. Data should also be presented graphically. Give each
graph a Figure caption (e.g. ‘Figure 1: A graph to show…’). Microsoft Word can insert these
automatically. If you need help in producing graphs using Excel, see the University CIS
‘Introduction to Excel 2007: Simple Formulae and Charts’ document (Chapters 6, 7 and 8).
This can be found at http://www.dur.ac.uk/resources/its/local/er-guides/ER004.pdf. This
link is available via DUO.
3. A brief comment on your final results, giving reference to tables and figures (e.g. Figure 2
shows the dependence of volume on pressure for…). Be sure to include the values for vapH
and the boiling point of ethanol determined experimentally.
4. A brief narrative statement of the outcome of the linear regression error analysis (i.e. give
the gradient and/or intercept and their errors) and the source of errors. Do not include a
copy of the full regression analysis output from Excel.
Feedback on your submission will be provided via DUO. Remember that this submission will count
5% towards your total practical mark for Core Chemistry 1B. Failure to submit the work by the
deadline will result in a mark of zero being awarded unless the appropriate procedures have been
followed (see p39 of the First Year Handbook).
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5B.7 Appendix 1 - Linear regression analysis with Excel
Excel can be used to determine lines of best fit to data that fits a straight line (after appropriate
manipulation). This can be done simply using the ‘add trend line’ function. However, this does not
determine errors associated with the gradient and the intercept. This can be done using the ‘data
analysis’ tools available with Excel. First, ensure that the data analysis tools are available. If they are
not, install them by following the instructions below:
Excel 2003
Click on the ‘add-ins’ option of the Tools menu, and then select the ‘Data Analysis ToolPak’ box. The
data analysis tools will then be available under the ‘Tools’ menu option.
Excel 2007
Click the Microsoft Office Button (top left corner - the four coloured logo), and then click Excel
Options.
Click Add-ins, and then in the Manage box, select Excel Add-ins.
Click Go.
In the Add-Ins available box, select the Data Analysis ToolPak check box, and then click OK.
The data analysis tools will then be available under the ‘Data’ menu option.
Excel 2010
Click the File tab and click Options.
Click Add-ins on the left hand menu. In the Manage drop down menu at the bottom of the page,
select Excel Add-ins.
Click Go.
In the Add-Ins available box, select the Data Analysis ToolPak check box, and then click OK.
The data analysis tools will then be available under the ‘Data’ menu option.
Steps 1-4 should be sufficient on a university network computer. If Data Analysis ToolPak is not
listed in the Add-Ins available box, click Browse to locate it. If you are prompted that the Analysis
ToolPak is not currently installed on your computer, click Yes to install it. It is possible that it will ask
for your MS installation disk, if you don’t have this, you will be unable to install the Analysis Toolpak
on your PC/laptop, in which case, use a university network PC. Once installed, use of the linear
regression is identical for 2003, 2007 and 2010 versions of Excel.
In order to use the linear regression software, highlight the columns containing the data to be fit
(including the headings), open the Data Analysis dialogue box, and select the Regression option.
From the box that opens, clicking on OK should produce the required analysis which may be
tabulated on a new sheet. A large amount of information is presented, as can be seen with the
example below, where analysis has been performed on an example data set. The important
information is in the first part of the final table (highlighted), which gives the intercept as 3.736 
0.190475163, and the gradient (X variable 1) as 0.196073  0.003069785. Of course, you should not
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just quote these values as they appear! Only use the appropriate number of significant figures for
the result and the error, and always quote units.
Example of output from linear regression using Excel 2010.
Data:
x
10
20
30
40
50
60
70
80
90
100

y
5.71
7.39
9.65
11.49
13.85
15.33
17.83
19.77
21.04
23.14

SUMMARY OUTPUT
Regression Statistics
Multiple R
0.999021
R Square
0.998043
Adjusted R Square 0.997798
Standard Error
0.278827
Observations
10

ANOVA
df
Regression
Residual
Total

1
8
9

Significance
SS
MS
F
F
317.1672436 317.1672436 4079.607666 4.01496E-12
0.621956364 0.077744545
317.7892

Intercept
X Variable 1

Coefficients
3.736
0.196073

Standard Error
0.190475163
0.003069785

t Stat
19.61410576
63.8718065

P-value
4.74773E-08
4.01496E-12

Intercept
X Variable 1

Lower 95%
3.296763486
0.18899379

Upper 95%
4.175236514
0.203151665

Lower 95.0%
3.296763486
0.18899379

Upper 95.0%
4.175236514
0.203151665
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SKILLS

EXPERIMENT 6A

6A. Data analysis toolkit: error propagation, data transformation, linear regression
and errors.
In Experiment 2A, an experiment was designed to collect some data about how much water a paper
towel soaked up. This generated 10 values which were analysed using simple statistic tools such as
mean, standard deviation and standard error (the standard deviation of the mean). This experiment
will allow more advanced data analysis to be practiced. The key to this experiment is to take the
time to understand the activities and their application to ‘real’ experimental data, not just to rush
through them as quickly as possible! Discuss the main issues with your group as you work through
the exercises together. The skills developed in this activity will be expected to be used during later
experiments in the course.
6A.1 Aims
 To perform an error propagation for previous experimental results
 To develop understanding of the use of Excel in data handling and data analysis
 To practice appropriate graph-drawing techniques
 To use a computer-assisted learning (CAL) package to develop understanding of common
ideas about errors in measurement
6A.2 Pre-lab exercises
These exercises must be completed at least one hour before the timetabled start time of the
laboratory session. Students not completing the pre-laboratory task will be turned away from the
laboratory until the exercises are completed.
1. Read through the laboratory activity instructions carefully and highlight any unfamiliar
words. Look these up in the following texts to ensure they are understood.
2. Re-read Gott, R. and Duggan, S. “Understanding Scientific Evidence – How to critically
evaluate data” 2003, Sage Publications, London, Thousand Oaks, New Delhi. The full text of
this book is available to all Durham students via the University Library web pages. Pay
particular attention to the chapters 1, 7, 8 and 9. An additional (and more thorough)
approach to the topics covered in this experiment can be found in Taylor, J. R. “An
Introduction to Error Analysis: The Study of Uncertainties in Physical Measurements”, 1997,
University Science Books, Sausalito, California. Durham University library shelfmark: 530.8
TAY.
3. Read over Experiment 3A and practice the calculation that was performed to calculate the
concentration of the sodium hydroxide solution so that it is familiar at the start of the
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laboratory session. Note down in your lab notebook the formulae for calculating standard
deviation and standard error (from Experiment 2A).
4. Prepare the lab notebook. This will include noting down the full titration results from Part 1
of experiment 3A, and making a note of the concentration of NaOH that you reported. If you
did not complete experiment 3A for some reason, take the results from someone else and
make a note of who the results were collected by.
5. If you are studying Core Chemistry 1B, also review your ‘Errors’ lecture course notes.
6A.3 Laboratory Activity
Working together in groups of two or three at a laboratory computer (group sizes of three are also
acceptable), take the time to read through the following information, work through any problems
individually using data from the lab notebook and then discuss the answers within the group.
Tackle the computer-based tasks together and take turns to practice each skill. This is a groupbased collaborative learning exercise so it is important that groups work together and discuss the
work.
Propagation of Errors
In science, the word ‘error’ does not have its usual connotations of ‘mistake’ or ‘blunder’. An error
in a reading may be random (an unpredictable fluctuation in a measurement or observation) or
systematic (an error introduced by an experimental flaw or miscalibration in equipment). Any
recorded measurement has an ‘uncertainty’ associated with it.
For example, a 25.00 cm3 accurate pipette may be used to measure out a volume of a liquid.
Looking carefully at the glassware, the manufacturer will usually have stamped the ‘uncertainty’ on
the side of the equipment. If the uncertainty is ±0.05 cm3, the volume measured out will not
definitely be exactly 25.00 cm3. The uncertainty in the glassware means that the volume of liquid
will be somewhere between 24.95 cm3 and 25.05 cm3. Thus this volume would be reported as
25.00 ±0.05 cm3. When reporting or analysing data from experiments, it is important to have an
understanding of the uncertainty inherent in any data. Every measurement taken during an
experiment has an uncertainty associated with it. Thus, any quantity calculated using any
measurement data will have an associated uncertainty that must be reported. The generic format
we use to report uncertainty is:
x = xbest ± x units
where xbest is the ‘best’ estimate of x obtained from experimental data and x is the uncertainty in
the measurement. The units must also be included for every quantity. Uncertainty may also be
reported as a percentage:
x = xbest ± z % units
where xbest is the ‘best’ estimate of x obtained from experimental data and z is 100(x/x).
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x is a measure of precision so this should not be reported to an unrealistic precision e.g. reporting
g = 9.82 ± 0.0235 m s-2, the 3 significant figures for the uncertainty are meaningless. It would be
much better to say: g = 9.82 ± 0.02 m s-2. Don’t just report the number of significant figures on the
calculator. As a ‘rule-of-thumb’, state the uncertainty to one significant figure, then quote the value
of the quantity to the same number of decimal places as the uncertainty (as shown for g, above).
In Part 1 of experiment 3A, the concentration of sodium hydroxide was calculated from an average
(mean) titre value determined experimentally and thus it will have an uncertainty associated with
it. The aim of this task is to determine the uncertainty in the final concentration that was reported
by considering the uncertainties involved in the experiment.
The raw datum, the average titre value, used in the calculation for Experiment 3A has an
uncertainty associated with it. This can be quantified by calculating the standard error that can be
calculated from the titration results.
Calculate the uncertainty in the average titre value reported in your lab notebook for Part 1 of
Experiment 3A (use your partner’s results if you did not complete this experiment). To do this, you
will need to calculate the standard error for the average titre, following the procedure used before
in Experiment 2A. To recap:
1. calculate the standard deviation:

1 n
1 n
2
2
x 
.  di  
.  xi  x 
n  1 i 1
n  1 i 1
where σx = standard deviation
xi = a single measurement
x = mean
n = number of titrations
2. calculate the standard error:

x 
where  x = standard error

x
n

σx = standard deviation
n = the number of readings
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Show the working and note the uncertainty value in the lab notebook. Report the uncertainty in the
format
x = xbest ± x units
where xbest is your average titre value for Part 1 of Experiment 3A and x is the calculated standard
error. Compare the values within the group and make any corrections to individual working, if
required. Show the values to a demonstrator.
To determine any quantity, q, mathematical manipulation of the raw datum, x, is usually required
i.e. q = f(x). In Experiment 3A, the raw datum, x, is the mean titre value for the 0.1000 ± 0.0001 mol
dm-3 solution of hydrochloric acid). The quantity, q, that is calculated from x is the concentration of
the sodium hydroxide solution, [NaOH]. Other quantities and numbers used to calculate [NaOH],.
were:
 the concentration of the HCl, (0.1000 ± 0.0001 mol dm-3). Remember that the chemical
shorthand for ‘the concentration of HCl’ is simply [HCl].
 the volume of the NaOH (25.00 ± 0.01 cm3). Use VNaOH to represent this quantity.
 the volume of HCl used (given by your average titre, with the uncertainty calculated above).
Use VHCl to represent this quantity.
Thus to calculate the uncertainty in the value reported for [NaOH], the uncertainties in these other
measurements must be taken into account, as these uncertainties will all be combined together in
the calculation of [NaOH]. This procedure is known as propagation of errors. Follow the steps
shown below to calculate the uncertainty in your result.
1. Considering the calculation that you performed to work out [NaOH], deduce a formula to show
how [NaOH] is calculated from VHCl, VNaOH and [HCl]. Be sure to show the units in the formula. Help
each other within the group to deduce an answer. Show the formula to a demonstrator.
2. The formula for the calculation of [NaOH] involves products and quotients (i.e. there are
quantities both multiplied and divided by each other). This is probably the most commonly
encountered type of calculation in chemistry. To propagate errors to determine the uncertainty in a
final number, q, the following formula should be used:

q

2

 x   y 
 u   w 
       ...        ...
q
 x  y
u  w
where x, y, u and w are the quantities used in calculating q and x, y, u and w are the
uncertainties in those values. Thus, for this example, the formula to be used to determine the
uncertainty in [NaOH], [NaOH], is:
2

2

2

2

2

 V    [ HCl ] 
 V

  HCl   
  . NaOH 
[ NaOH ]
 VHCl   [ HCl ] 
 VNaOH 

 [ NaOH ]

2
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Use this formula to calculate the uncertainty in your value for [NaOH], and report in the same way
as in Exercise 1. Help each other to reach an answer, then compare your value with your partner.
Show a demonstrator your results when complete.
Using Excel to analyse data sets and draw graphs
Often, when carrying out an experiment, data can be recorded directly into Excel. The spreadsheet
is a powerful tool for analysing data sets. In this task, you will practice using Excel to perform
calculations on data and to produce graphs. Use the Help function in Excel (press F1) to assist if you
cannot work out how to do each step, or ask the demonstrator.
Below is a table of data which would, if plotted, produce a straight line graph of the form y = mx + c,
where m is the gradient of the line and c is the intercept. Open Excel and enter the data exactly as it
appears below:
x / units of x
0
1
2
3
4
5
6
7
8
9
10

y / units of y
-3.60
-1.00
4.30
7.98
10.64
14.40
19.05
21.67
25.27
29.30
34.06

Use Excel functions to construct columns showing the values of x2 and x.y. Determine the sums of
the four columns to give ∑x, ∑y, ∑x2 and ∑x.y and display the values as a row at the bottom of the
table. Using the formulae given on the formula sheets (available near each computer), use Excel
calculate a value for the gradient, m and a value for the intercept, c, for this data. This should be
done within Excel and not calculated by hand (i.e. do not use a calculator). To do this, select a new
cell, and begin by typing =( ) then construct the required formula within the brackets, clicking on
the relevant cells where required. Show a demonstrator the values you have calculated, and
demonstrate what happens to the values of m and c if the cell x=3 is changed to x=3.5. [Hint: if
the formulae are set up correctly, changing the value of 3 to 3.5 should automatically alter the
values of m and c.]
Excel has some built-in functions to determine the gradient, m, and intercept, c, called SLOPE and
INTERCEPT. To use these, first select an empty cell. Click on ‘Insert’ and select ‘Function’. Choose
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SLOPE from the list of statistical functions. Select the x and y data by clicking and dragging the
mouse, then click OK. The SLOPE value should now be shown on the spreadsheet. Repeat this
process but select INTERCEPT from the statistical functions to determine a value for the intercept.
Check that the values match the values for m and c calculated above.
Using the Chart function in Excel, draw a scatter graph of x vs y and display it as a separate sheet.
Make sure that axis labels (‘y / units of y’ and ‘x / units of x’) are shown and add a title. This title
should have the names of the group members in it e.g. ‘Sample scatter graph produced in Excel
with trendline added – Joe Bloggs and Jane Doe’. Format the points so that they show as either
crosses or triangles. Format the y axis so that the number labels are displayed with no decimal
places. Investigate the effect of adding and removing major and minor gridlines to the plot area,
then remove all gridlines to give a plain white plot area surrounded by a border. Select the data
points and right click to add a trendline. Display the equation on the trendline so that values for m
and c can be seen. These should match the values calculated using the SLOPE and INTERCEPT
functions above. Name the sheet in which the chart appears as ‘Sample Graph’. Show your graph
to a demonstrator, print off a copy each and stick it into your lab notebook.
Using Excel to perform linear regression
As we have seen, Excel can be used to determine the line of best fit for data that fits a straight line
(after appropriate manipulation). This can be done simply using the ‘add trend line’ function on a
graph, or by using the SLOPE and INTERCEPT functions. However, this does not determine errors
associated with the gradient and the intercept. This can be done using the ‘data analysis’ tools
available with Excel. These should be already installed on the laboratory computers. If you wish to
use linear regression at a later date, however, you may need to install them on your own or a
University network computer so the instructions are given in Appendix 1 (on page 33):
In order to use the linear regression software, highlight the cells containing the data to be fit
(including the headings), open the Data Analysis dialogue box (in the Tools menu), and select the
Regression option. From the box that opens, clicking on OK should produce the required analysis
which may be tabulated on a new sheet.
Take it in turns to use Excel to generate a linear regression output using the data given above. A
large amount of information should be presented, as shown below. The important information is in
the first part of the final table (highlighted below), which gives the intercept as 3.736 
0.190475163, and the gradient (X variable 1) as 0.196073  0.003069785. Of course, you should not
just quote these values as they appear! Only use the appropriate number of significant figures for
the result and the error, and always quote units. Show a demonstrator that you can perform linear
regression on the data set to generate the same results as are given below.
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Sample data for practising linear regression:
x
10
20
30
40
50
60
70
80
90
100

y
5.71
7.39
9.65
11.49
13.85
15.33
17.83
19.77
21.04
23.14

SUMMARY OUTPUT
Regression Statistics
Multiple R
0.999021
R Square
0.998043
Adjusted R Square 0.997798
Standard Error
0.278827
Observations
10

ANOVA

Regression
Residual
Total

df
1
8
9

SS
317.1672436
0.621956364
317.7892

Significance
MS
F
F
317.1672436 4079.607666 4.01496E-12
0.077744545

Intercept
X Variable 1

Coefficients
3.736
0.196073

Standard Error
0.190475163
0.003069785

t Stat
19.61410576
63.8718065

P-value
4.74773E-08
4.01496E-12

Intercept
X Variable 1

Lower 95%
3.296763486
0.18899379

Upper 95%
4.175236514
0.203151665

Lower 95.0%
3.296763486
0.18899379

Upper 95.0%
4.175236514
0.203151665

Once you are happy you can use the Regression tool to determine the errors in the gradient and
intercept and the values match those given in this table, try it again using the data used to produce
the graph earlier and check that the values match those calculated using the trendline function, and
using SLOPE and INTERCEPT. Note the gradient and intercept value with their uncertainty in the
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appropriate way, paying attention to the number of significant figure. Show a demonstrator the
values with uncertainties to an appropriate number of significant figures.
Use of the computer-assisted learning package
In this section, a Computer Assisted Learning Package (CAL) is used to develop and illustrate some
of the concepts that are important when considering errors in measurement.
On a laboratory computer, select the ‘6A Errors’ shortcut on the desktop, then open ‘6A CAL
Package’. The program should then start to load. The program may flash up a warning window,
warning you that the program contains macros, and ask how to proceed. Click on "Enable Macros"
and the program will start to run. If any other error messages are generated, ignore them and
proceed to open the package. Be sure that the ‘Text’ sheet is visible, enter the names of the group
at the top of the sheet and work through the exercises in turn.
From time-to-time you may find that some error messages pop-up - often this is because you try to
enter data into a protected cell (i.e. one that you're not allowed to change). Don't panic, click OK
and carry on. If in doubt, ask a demonstrator.
At the end, print out a copy of the results sheet (with the name of you and your partner on it) and
stick it into your lab notebook. Show this to a demonstrator.
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6A.4 Appendix 1 – Installing the Data Analysis Toolpak in Excel
If the Data Analysis tools are not available in Excel, install them by following the instructions below:
Excel 2003



Click on the ‘add-ins’ option of the Tools menu, and then select the ‘Data Analysis ToolPak’
box.
The data analysis tools will then be available under the ‘Tools’ menu option.

Excel 2007






Click the Microsoft Office Button (top left corner - the four coloured logo), and then click
Excel Options.
Click Add-ins, and then in the Manage box, select Excel Add-ins.
Click Go.
In the Add-Ins available box, select the Data Analysis ToolPak check box, and then click OK.
The data analysis tools will then be available under the ‘Data’ menu option.

Excel 2010






Click the File tab and click Options.
Click Add-ins on the left hand menu. In the Manage drop down menu at the bottom of the
page, select Excel Add-ins.
Click Go.
In the Add-Ins available box, select the Data Analysis ToolPak check box, and then click OK.
The data analysis tools will then be available under the ‘Data’ menu option.

Steps 1-4 should be sufficient on a university network computer. If Data Analysis ToolPak is not
listed in the Add-Ins available box, click Browse to locate it. If you are prompted that the Analysis
ToolPak is not currently installed on your computer, click Yes to install it. It is possible that it will ask
for your MS installation disk, if you don’t have this, you will be unable to install the Analysis Toolpak
on your PC/laptop, in which case, use a university network PC. Once installed, use of the linear
regression is identical for 2003, 2007 and 2010 versions of Excel.
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SKILLS

EXPERIMENT 6B

6B. Use of Excel to analyse large data sets1
In the titration exercises in Experiment 3A, each student in the year group standardised a solution
of NaOH and then determined the Mr of an unknown acid. This produced a large amount of data. It
is useful to be able to analyse individual results in the context of this collective data, in the same
way that a titration result may have been compared to a whole-class result previously during
titration exercises. A familiar method for dealing with more than one piece of data is to calculate a
simple mean. Treatment of large data sets, however, often involves a number of accepted
statistical analyses other than calculating a mean (or sometimes in order to calculate a mean). The
large amount of data involved means that modern spreadsheet software provides an efficient way
of handling large data sets. This experiment will allow you to learn how Excel can be used for the
analysis of large data sets, and to use some of the tools using data from real class results.
6A.1 Aims
 To perform data analysis on a large data set using Excel, including removing outliers,
plotting frequency histograms and fitting of histograms to normal distributions using leastsquares minimisation algorithms.
 To develop understanding of the meaning of accuracy and precision
 To critically evaluate individual experimental results in the context of the collective data
6A.2 Pre-lab exercises
These exercises must be completed at least one hour before the timetabled start time of the
laboratory session. Students not completing the pre-laboratory task will be turned away from the
laboratory until the exercises are completed.
1. Review the Errors in Measurement lecture course notes, particularly the sections on the
Normal or Gaussian distribution and the use of ‘Normal Fitting’ of data. Use the lecture
notes and the two texts suggested below to develop your understanding of key concepts in
data analysis, as well as looking up Normal or Gaussian distributions elsewhere if required.
Suggested texts are:
(a) Gott, R. and Duggan, S. “Understanding Scientific Evidence – How to critically evaluate
data” 2003, Sage Publications, London, Thousand Oaks, New Delhi. (This book is available as
an e-book via the University Library web pages or via the link in DUO)

1

This experiment is adapted from Ling, C. D. and Bridgeman, A. J., J. Chem. Educ., 2011, 88, pp979-982.
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(b) Taylor, J. R. “An Introduction to Error Analysis: The Study of Uncertainties in Physical
Measurements”, 1997, University Science Books, Sausalito, California. Durham University
library shelfmark: 530.8 TAY.
2. Look up at least four different common diprotic weak organic acids and note down their
structures and Mr values.

6A.3 Laboratory activity
Analysis of the data from standardisation of NaOH
This section will demonstrate how to fit a normal distribution to a large data set as an alternative
method for determining the mean and standard deviation.
1. Working in groups of two or three, find a free computer in the laboratory and open the file
named ‘6B Errors Standardisation of NaOH results’ in Excel. This file contains an example set
of data from a titration exercise similar to the one performed in Experiment 3A.
2. Save a copy of the file using 6B and the surnames of the group in the filename (e.g.
6ABloggsSmithJones.xls) onto the desktop before beginning to work with the data.
3. Sample results from an experiment by a whole class to standardise NaOH (i.e. to determine
the concentration of a solution of NaOH) are given in Column B (‘Values Reported’). The
numbers to extract as results at the end of the analysis (the mean and the standard
deviation) are in blue text. The numbers in black have been generated from the ‘Values
Reported’ to be used to calculate the mean ( x ), the standard deviation (σx) and to plot a
frequency histogram of the results (see Figure 6B.1). Take some time to look at the data.
The value of the mean (shown in blue) includes all the data (all the red numbers). Decide if
there are any outliers in the data that should be removed when calculating the mean. If so,
calculate a mean without including these outliers and note it. This is very simple to do using
Excel: highlight the red numbers required and note the ‘Average’ value that appears at the
bottom of the screen. To omit outliers, simply use the control key whilst dragging the mouse
to highlight all data to be included and skip over the outliers.
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Figure 6B.1: Frequency histogram of the original data. Most data is in one bin so the defined range needs changing

4. The range (in the red box) is currently defined to cover all the experimental observations of
concentrations of NaOH solution. It can be seen that almost all the data are currently in a
single bin in the frequency histogram (shown in Figure 6B.1) apart from extreme outliers.
Double-check that the file being worked on is saved with an appropriate filename, then
adjust the centre and width of the defined range (the red numbers in cells F4 and F5) to try
to obtain meaningful values for x and σx, as judged by observing changes in the frequency
histogram plot. Changing these values will remove some outliers and alter how the data is
presented on the histogram. The aim is to alter the values until a frequency histogram is
produced that resembles a Normal (Gaussian) distribution, with the centre peak
corresponding to the mean of the data.
5. To ensure the centre of the data corresponds well to the mean, a normal (Gaussian)
distribution curve can be fitted to the data. A normal distribution has the form
y  ae  x b 

2

/ 2 c2

 where a is the maximum of the peak defined by the normal distribution, b is

the centre and c is the standard deviation associated with the centre. The full-width at half
maximum (fwhm) is 2(2ln2c)1/2. The spreadsheet automatically generates reasonable
starting guesses for a, b and c based on x and σx for the selected range. These numbers are
shown in green in cells F20, F21 and F22. Copy these numbers into the corresponding red
cells in the ‘Optimised values for Gaussian’ box (cells F26, F27 and F28). A normal
distribution should appear on the frequency histogram plot. Check that the starting guesses
give a typical and sensible normal distribution curve. If not, adjust a, b and c slightly until the
normal curve fits the data. If the normal curve cannot be made to fit sensibly, go back and
adjust the histogram centre and bin width and try again. Keep making adjustments until the
curve looks like a normal distribution.
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6. The Solver function in Excel can optimise this fitting of data (by optimising the Gaussian
values a, b and c) to obtain a good distribution. The optimisation process improves the
values of a, b and c so that the calculated frequencies νcalc (shown in Column K) match the
experimental frequencies νobs (shown in Column J) as closely as possible. The Solver function
does this by minimising the value of the residual (νobs - νcalc)2 in cell F14 by changing a, b and
c in cells F26-F28. To use the function, click on Solver. In the ‘Set Objective’ box select cell
F14 and click the ‘Min’ button. In the ‘By changing variable cells’ box, select F26-28. Then
click Solve. The values in the Optimised Values for Gaussian box will now have changed
slightly, as will the normal distribution curve.
7. The values in the blue boxes (cells F9 and F10) are the values for the mean x and the
standard deviation σx after fitting a normal distribution. The b and c value in the ‘Optimised
values for Gaussian’ are the mean and standard deviation determined by the Solver
function. Note down the value of the mean with the one calculated at the beginning of the
exercise using observation alone. Show the demonstrator your results.
8. Now ‘real’ data from results obtained earlier this term by the entire class group will be used.
Save a copy of the file with a different name (by adding a 2 at the end of the original
filename e.g. 6ABloggsSmithJones2.xls). Delete the red numbers in the ‘Optimized values for
Gaussian’ box (cells F26, F27 and F28) to avoid confusion. Open the file ‘6B NaOH
Standardisation Data Autumn 2011’. This file contains the data obtained by the whole year
group during experiment 3A. Copy and paste the values for the concentration of NaOH into
Column B (‘Values reported’, the red numbers) of the file.
9. Follow steps 3 to 7 to establish a value for the mean and standard deviation for the data by
fitting a normal distribution curve and then by using the Solver function. How well does the
data fit a normal distribution curve compared to the ‘sample’ data used first? How does the
mean value obtained individually by each student in the group during Experiment 3A
compare with the class mean and standard deviation? Discuss this within the group and
note the findings.
Analysis of the data from determination of the molar mass of an unknown acid
This kind of Normal or Gaussian fitting of data can also be used in a more powerful way. In
Experiment 3A, the whole class determined values for the Mr of an unknown acid by using titration.
This is a typical undergraduate experiment. Results from a similar laboratory class experiment will
be analysed here, but in this case there were three unknown acids available in the laboratory, Acids
A, B and C, and each student was randomly assigned one of three acids. The whole class results
varied quite significantly and there were three possible ‘correct’ values of M r. There was also less
data produced per acid. Trying to analyse this data by hand without knowing which student was
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assigned which acid would not be a trivial task. Use of this kind of Excel data analysis and normal
fitting, however, allows a simple analysis of this complicated data.
Open the file ‘6B Errors Mr of unknown acids’ and save a copy of the file with a different name (by
adding a 3 at the end of the original filename used e.g. 6ABloggsSmithJones3.xls). This file contains
the sample Mr data from a real class using three different unknown acids in Column B (‘Values
reported’, the red numbers). The centre and width of the defined range (in cells F4 and F5) have
been set to include all the observed values of Mr. This frequency histogram should contain three
discrete peaks corresponding to the Mr of the three different acids.
Again, roughly follow steps 3 to 7 above, analyse the results to get the optimum mean Mr and
standard deviation for each of the three acids using the Solver function. This time, however, there
should be three discrete ranges defined to focus on each of the three peaks (and thus the three
unknown acids) individually.
Once a reasonable Mr value is determined (using the Solver function) for each acid, compare the
values to those noted down as part of the pre-lab exercises to identify which three acids were used.
Use the CRC Handbook available in the laboratory to help if there is insufficient data in the group to
identify the acids (which are all common diprotic weak organic acids).
Show a demonstrator your mean and standard deviation values for each acid, and the suggested
identity of each acid.
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PREPARATION OF PEAR
ESSENCE (PROPYL ACETATE)

First Year Chemistry Laboratory Course 2011-2012: SKILLS
40

SKILLS

EXPERIMENT 7A

7A. Preparation of pear essence (propyl acetate)

O
O
This ester is prepared by the well-known esterification process that should be familiar from
previous studies (the reversible reaction between a C-OH containing compound and an acid to give
an ester plus water). Ethanoic acid (acetic acid) is used as an acylating agent in the presence of a
catalytic amount of concentrated sulfuric acid.
The esterification process is the most well-known equilibrium-controlled (reversible) reaction in
organic chemistry, which is shifted to the right, in favour of the ester, by using a much higher
concentration (excess) of one of the starting materials:
O

H+
OH

+

CH3CO2H

O

+

H2O

7A.1 Aims
 To refresh knowledge about use of spectra to identify unknowns from prior knowledge
 To develop a detailed synthetic and purification method from an outline procedure
 To further develop confidence with use of reflux apparatus
 To use distillation as a purification technique
 To determine a melting point of a product to determine purity
7A.2 Pre-lab exercises
These exercises must be completed before the experiment, and completed at least one hour before
the timetabled start time of the laboratory session. Students not completing the pre-laboratory
task will be turned away from the laboratory until the exercises are completed.
1. Read the instructions in the laboratory manual through carefully and highlight unfamiliar
words or apparatus.
2. In DUO, in the Core Chemistry 1A Laboratory Course section, open Foundation Chemistry
LabSkills and click to begin. Click on the ‘Equipment Glossary’ or the ‘Reagent Glossary’ at
the top of the screen to identify any unfamiliar words contained in your laboratory manual.
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3. Using Foundation Chemistry LabSkills, look over the Reflux and Filtration (vacuum filtration
–Buchner apparatus) sections to ensure familiarity with these techniques which have been
used already during this laboratory course.
4. Preparing for use of a separating funnel: Using LabSkills, under the ‘Preparation and
Purification’ sub-heading, select ‘Solvent Extraction’ and read the introduction about the
use of a separating funnel. Watch the video demonstrating the use of a separating funnel.
Use the simulation to practice using the separating funnel, and read about the drying
liquids. Read through and pay close attention to the safety aspects of the procedure. It may
also be useful to look through the relevant sections on the Chemistry Interactive Lab Primer
(http://chem-ilp.net) if this technique has not been used before.
5. Preparing for the distillation: Using LabSkills, under the ‘Preparation and Purification’ subheading, move the cursor over ‘Distillation’ and then select ‘Technique’ from the pop-up list.
Read the first page about distillation, and use the simulation on the second page to practice
setting up distillation apparatus. Then select ‘Video’ and watch the procedure again, and
then select ‘Safety’ and read through the safety points, focusing particularly on the use of
stirrer hotplates. It may also be useful to look through the relevant sections on the
Chemistry Interactive Lab Primer (http://chem-ilp.net) if this technique has not been used
before.
6. Complete the Spectroscopy Exercise, available on DUO. Answers should be presented in a
Word document, with all data tabulated with units. Submit the completed document via
DUO.
7. Prepare the lab notebook. Include the mechanism for the reaction of R-OH with CH3CO2H,
indicating clearly the role of the H+ (from H2SO4), using textbooks to assist, if required. [Hint:
This is a new mechanism not previously covered at pre-University level in the majority of
cases.]
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7A.3 Risk assessment
CHEMICAL

RISKS

SAFETY

Propan-1-ol

Highly flammable, irritant Risk of
serious damage to eyes. Vapours
may cause drowsiness and
dizziness.

Glacial acetic acid
(glacial ethanoic acid)

Flammable. Corrosive. Causes
severe burns.

Keep away from sources of
ignition. Avoid contact with skin.
In case of contact with eyes, rinse
immediately with plenty of water.
Wear eye/face protection.
Wear gloves. Do not breathe
gas/fumes/vapour/spray. In case
of contact with eyes, rinse
immediately with plenty of water.
In case of contact with eyes, rinse
immediately with plenty of water.
Never add water to this product
Wear gloves. Use in fumes
cupboard.
Keep away from sources of
ignition. In case of contact with
eyes, rinse immediately with plenty
of water. Do not empty into
drains. Take precautionary
measures against static discharges.

Concentrated sulphuric Causes severe burns. Corrosive.
acid

Propyl acetate

Highly Flammable. Irritating to
the eyes. Repeated exposure may
cause skin dryness or cracking.
Vapours may cause drowsiness
and dizziness

5% Sodium
bicarbonate solution

Irritant.

In case of contact with eyes, rinse
immediately with plenty of water.

Saturated aqueous
sodium chloride

Limited evidence of a
carcinogenic effect.

Avoid contact with skin and eyes.

Anhydrous magnesium
sulfate

-

Do not breathe dust. Avoid contact
with skin and eyes.

7A.4 Laboratory activity
Show a demonstrator the prepared lab notebook to confirm completion of the pre-lab exercises.
Work in pairs but keep individual records in lab notebooks as the experiment proceeds. Choose a
work area with a free locker and a fume cupboard to work in, and write the number of these at the
top of the lab notebook page for this experiment. Inform the demonstrator of the locker and fume
cupboard number.
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Work in a fume cupboard for the duration of the experiment. Think carefully about use of stoppers
and bungs to prevent flammable vapours escaping into the laboratory during any transfer of liquids
during the experiment.
1. In a fume cupboard pour 12 cm3 (9.6 g) of propan-1-ol and 24 cm3 (24 g) of glacial acetic
acid into a 100 cm3 round bottomed flask. Carefully add 4 cm3 of concentrated sulfuric acid
to the contents of the flask, with swirling. Add a magnetic stirrer bar to the mixture.
2. Assemble a reflux apparatus. Show a demonstrator the apparatus before beginning to
heat the reaction.2 Bring the mixture to the boil using a hotplate and heating block. Allow
the mixture to reflux for one hour. Remove the heating source and allow the mixture to
cool to room temperature. Prepare the next stages while the reaction is refluxing and
cooling, and begin work on the exercises at the end of the instructions (remembering to
keep the experiment under close observation). Write answers to the exercises onto the left
hand page of the lab notebook.
3. In a fume cupboard, pour the cooled mixture into a separating funnel and carefully add 50
cm3 of cold deionised water. Rinse the reaction flask with 10 cm3 of cold water and pour
the rinsings into the separating funnel. Stopper the separating funnel and shake it several
times. Separate the lower aqueous layer from the upper organic layer (density = 0.87 g/ml).
Only discard the aqueous layer at the end of the experiment after the pure product has
been isolated.
4. Add approximately 30 cm3 of 5% aqueous sodium bicarbonate (sodium hydrogencarbonate,
NaHCO3) carefully to the organic layer contained in the separating funnel. Swirl the
separating funnel gently until carbon dioxide gas is no longer evolved. Stopper and gently
shake the funnel, regularly releasing the pressure, until no more CO2 is evolved. Remove the
lower layer and repeat the above extraction with 30 cm3 of 5% sodium bicarbonate solution.
Remove the lower layer and check to see if it is basic using pH indicator paper (use a glass
rod to transfer a drop of solution to a small piece of pH paper on a white tile). If it is not
basic, repeat the procedure with additional 30 cm3 portions of 5% base until the aqueous
layer is basic.
5. Wash the organic layer with one 25 cm3 portion of water, adding 5 cm3 of saturated
aqueous sodium chloride to aid in layer separation. Swirl the mixture gently - do not shake
it! Carefully separate the lower aqueous NaCl layer and put it on one side. Pour the
2

The demonstrator will check and mark the apparatus set-up, but will also double-check that there is no stopper in the
top of the apparatus. A common (and dangerous) mistake is to leave a stopper in the apparatus, sealing it, and then
heating. Heating a sealed system is very dangerous as it can lead to explosion, so always double-check that your
apparatus is not sealed before beginning to heat a reaction mixture.
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remaining ester from the separating funnel into a dry 100 cm3 conical flask. Add about 2 g
of anhydrous magnesium sulphate to dry the ester. Stopper the flask to swirl it gently.
Allow the crude ester to stand until the liquid is clear; about 15 minutes will be required in
order for complete drying to occur (if the solution is still cloudy after 15 minutes, decant the
liquid and add to it another 1 g quantity of drying agent.)
6. In the fume cupboard, assemble a dry B10 distillation apparatus3 with B10 necked pear
shaped flask (see display set-up next to the balance bench). Carefully filter the ester into
the distillation flask through a fluted filter paper so that the drying agent is excluded. Add
three anti-bumping granules and distil the ester, collecting the main fraction, which will
have a constant boiling point, in a pre-weighed sample bottle (+ lid). Collect any liquid which
distils over before the temperature becomes steady (i.e. impurities) in a separate bottle.
Swap receivers when the temperature becomes steady. Note this temperature. Record the
mass of the product obtained and calculate the % yield, carefully considering which starting
material is yield-determining.
7. Rinse out the apparatus with acetone putting the washings into the C waste, and return all
clean apparatus. Discard the basic washings down the sink in the fume cupboard. Tidy the
bench space and fume cupboard and turn off all taps and plug sockets.
8. Complete any of the following exercises that have not already been completed during the
experiment. Once complete, show a demonstrator the lab notebook, the tidy fume
cupboard, tidy work bench and tidy lab locker to get signed off.

Exercises
Write answers to the following questions, including an equation to illustrate the answer to question
2, into the lab notebook.
1. What is the good leaving group in the final stage of this reaction?
2. What reagent is used to remove the excess acetic acid, some of which will be present in the
crude ester?
3. As a result of this, what has happened to the sulfuric acid?

3

Remember that ‘B10’ indicates the size of the glass joint on the flask. All of the glassware in the teaching lab is ‘B’ and
is typically B10, B14, B19 or B24 in size. The numbers indicate the diameter of the joint. Thus a B10 joint is probably the
one with the smallest diameter in your laboratory locker. The size is often indicated near the neck of the glassware.
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7B. Hydrolysis of methyl benzoate
In Experiment 7A, an ester was prepared from a carboxylic acid and an alcohol using concentrated
acid as a catalyst. The synthesis involved the use of reflux apparatus, followed by washing in a
separating funnel and distillation to purify the product. Purity was determined by the analysis of
the boiling point of the product.
This experiment will involve the reverse reaction, the hydrolysis of an ester, again using reflux, to
produce an alcohol and a solid acid. The solid product will be isolated by vacuum filtration and
purified by recrystallisation. The purity of the product will be determined by taking a melting point
of the solid acid.
7B.1 Aims
 To develop a detailed synthetic and purification method from an outline procedure
 To further develop confidence with use of reflux apparatus
 To practice recrystallisation as a purification technique
 To determine a melting point of a product to determine purity
7B.2 Pre-lab exercises
These exercises must be completed at least one hour before the timetabled start time of the
laboratory session. Students not completing the pre-laboratory task will be turned away from the
laboratory until the exercises are completed.
1. Read the instructions in the laboratory manual through carefully and highlight unfamiliar
words or apparatus.
2. In DUO, in the Core Chemistry 1A Laboratory Course section, open Foundation Chemistry
LabSkills and click to begin. Click on the ‘Equipment Glossary’ or the ‘Reagent Glossary’ at
the top of the screen to identify any unfamiliar words contained in the laboratory manual.
3. Using Foundation Chemistry LabSkills, look over the Reflux and Filtration (vacuum filtration
– Buchner apparatus) sections to ensure familiarity with these techniques which have been
used already during this laboratory course.
4. Again using LabSkills, select ‘Recrystallisation’ from the menu and re-read about the
technique and the safety aspects, watch the video and use the simulation to practice
recrystallising a solid. This method was used previously in Experiment 3A. No further
instructions will be provided about recrystallisation in this laboratory manual, so use
LabSkills thoroughly to prepare for the experiment.
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5. Select ‘Melting Point’ from the main menu and read about the technique, watch the video
and read the safety information thoroughly. Practice taking a melting point using the
simulation. No further instructions will be provided about taking a melting point in this
laboratory manual, so use LabSkills thoroughly to prepare for the experiment.
6. Prepare the lab notebook for the experiment. Construct the two balanced chemical
equations for this experiment. [Hint: the first reaction is between methyl benzoate and
sodium hydroxide. The second is between the salt produced and hydrochloric acid to
liberate the benzoic acid product]. Expand on the method given in this laboratory manual to
ensure that a complete and detailed set of instructions have been prepared for use in the
laboratory before the laboratory session begins. This should include a more detailed
method for performing the recrystallisation and the melting point determination (using
LabSkills to assist), and sizes of all glassware should be determined. Diagrams of any
unfamiliar apparatus should be drawn. Look up and note down the density of methyl
benzoate.
7B.3 Risk assessment
CHEMICAL

RISKS

SAFETY

Methyl benzoate

Flammable. Irritant.

Sodium hydroxide (2 M)

Causes burns. Corrosive. Take
care especially when it is hot.

Wear suitable protective
clothing.
In case of contact rinse
immediately with plenty of
water. Wear suitable
protective clothing and gloves
when handling.

Hydrochloric acid (2 M)

Causes burns, irritating to
eyes, skin and respiratory
system.

In case of contact rinse
immediately with plenty of
water. Wear suitable
protective clothing and gloves
when handling.

Benzoic acid

Harmful, irritant.

In case of contact with eyes,
rinse immediately with plenty
of water.
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7B.4 Laboratory activity
Show a demonstrator the prepared lab notebook to confirm completion of the pre-lab exercises.
Work in pairs but keep individual records in lab notebooks as the experiment proceeds. Choose a
work area with a free locker and a fume cupboard to work in, and write the number of these at the
top of the lab notebook page for this experiment. Inform the demonstrator of the locker and fume
cupboard number.
Work in a fume cupboard for the duration of the experiment. Think carefully about use of stoppers
and bungs to prevent flammable vapours escaping into the laboratory during any transfer of liquids
during the experiment.
1. Add 2 cm3 of methyl benzoate, 30 cm3 of 2 M sodium hydroxide solution, a few antibumping granules and a magnetic stirrer bar into an appropriately sized round bottomed
flask.
2. Assemble reflux apparatus. Bring the mixture to the boil using a hotplate and heating block.
Allow the mixture to reflux for forty five minutes. Remove the heating source and allow the
mixture to cool to room temperature.
3. Pour the cooled mixture into 50 cm3 of 2 M hydrochloric acid. A white precipitate should
form. Show a demonstrator the beaker containing the white precipitate.
4. Isolate the product using vacuum filtration and recrystallise the solid in a small conical flask
or beaker from hot deionised water.
5. Isolate the pure product using vacuum filtration. Dry as well as possible and record the mass
of the product obtained. Calculate the percentage yield and record it, with working, in the
lab notebook. [Please remember that this calculation requires you to start by calculating the
number of moles of the reactants.] Place the sample in a clean, labelled sample bag (not a
weigh bottle!). Show the % yield calculation to a demonstrator.
6. Determine a melting point of the pure solid. If time allows, a rough and two accurate
readings should be taken before a final melting point is reported. Show your value to the
demonstrator to have the purity of the product assessed. Hand the demonstrator the
bagged, labelled sample for assessment.
7. Dispose carefully of any waste (ask if unsure), wash and return all equipment and ensure all
power sockets and hotplates are switched off. Show a demonstrator the completed lab
notebook, the clean and tidy workspace, the clean and tidy fume cupboard and the
equipment locker to get them signed off before leaving the laboratory
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APPENDIX A: Assessment guide for laboratory reports
Reports will be assessed against the following criteria, which are not necessarily equally weighted.

First
Class

Structure

Presentation

Technical Content

Results and
Discussion

Excellent, very clear,
logical subdivision.

Well written in good
English, cogent
arguments presented.
Conclusions concur
with results obtained,
results are clearly
summarised.

Appropriate
theoretical
background included.
Proper use made of
theory expressions,
etc.

Critical assessment of
the results. Quality of
sample based on data
(spectra, errors).
Graphs neatly plotted
and correctly
interpreted. Extended
interpretation based
on analysis of theory
section.
Results analysed and
assessed in sufficiently
critical manner.
Evidence of an
appreciation of
sources of error.
Satisfactory
assessment of results
and outcome of
experiments. Critical
evaluation not overly
evident.
Poor analysis of the
results or sample
quality, no attempt to
assess sources of error
or where things may
have gone wrong.
No assessment of the
results, no discussion.

Upper Well organised easy to Clearly laid out,
Second follow and a sense of conclusions and
direction throughout.

summary evident and
clearly written.

Good grasp of the
necessary theory and
its use.

Lower Satisfactory but some
Second loss of way evident.

Straightforward to
read, satisfactorily
written, vagueness or
hesitancy in
conclusions and
summary.
Somewhat
disorganised and hard
to read. Conclusion
and summary
incorrect or “off the
mark”.
Difficult to read; slap
dash presentation,
absence of conclusion
or summary.

Only the basic theory
behind the
experiment is
presented, no
evidence of real
understanding.
Gaps in understanding
evident from what
was presented.

Third

No direction, no
subdivision. Lack of
clarity.

Fail

No evidence of any
organisation, absence
of basic
understanding, no
coherence.

No real presentation
of background and its
appreciation.
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